
 

 

	
	

	

Getting Started 
Download 10-day FREE Trial here (http://www.actmobilemessenger.com/try/) 

IMPORTANT -- ACT Mobile Messenger works with Act! ONLY 
Fill out the online form and you will receive an email with a link to download ACT Mobile Messenger. The 10-day FREE 
Trial is an unrestricted full-featured working copy. The software will count down one day at a time, with a warning on the 
last 3 days. After this time, the software will become disabled and cannot be used until licensed. 

Installation  
1. Close ACT! 
You must close ACT! prior to the installation of the ACT Mobile Messenger  
 
2. Log on to your PC as an Administrator (this may mean logging off, restarting your machine, or server) 
Ensure that you have logged on as an administrator on your local machine. If you are not sure what this means than this 
might be the right time to contact your IT support person, network administrator or IT services company. 
 
3. Double-click on the downloaded file: ActMobileMessenger.msi  
The Installation Wizard will guide you through installation.  
 

 
 
If you need help, please use you free email support and email us at support@actmobilemessenger.com  
 
4. Accept License Agreement 
ACT Mobile Messenger is licensed to run on a single machine that is running Act!. You can install the software on 
multiple machines that share a common Act! database, however you will need to have additional ACT Mobile Messenger 
licenses. After 10 days, if you do not purchase, the software will cease to function. After purchase, you need to register 
the software. The reseller who sold it to you will provide a registration key via email shortly after purchase.  
 

 
5.  Choose a Gateway Provider  
In order to send SMS texts from Act!, you’ll need a messaging Gateway Provider. Gateway Providers offers web- based 
services for sending text messages and for managing your account including message credits. ACT Mobile Messenger 
comes bundled with a range of Message Connectors that are designed to connect to the Gateways, much in the same 
way printer drivers allows you to connect to specific printers. ACT Mobile Messenger is the only product of it’s kind for 



 

 

	
	

	

Act! to offer a choice of message providers (Gateway Providers). For more information on the providers supported or 
how to setup your trial account including FREE messages refer to the back of this document. 
 

 
 
Typically, you would install only the Message Connector you are going to use, but you can install as many as you like. 
Currently, there are sixteen (16) Message Connectors, for each of the Gateway Service Providers supported. Each offers 
a free trial period with FREE sample SMS text messages so you can try the ACT Mobile Messenger during your trial. If 
we do not support one that you are currently using, or would like to use, we may be able to develop a custom connector 
for you.  
 
6. Choose Launch Act! with Mobile Messenger check-box   
It is recommended that you select the Launch Act! with ACT Mobile Messenger check-box prior to finishing the 
installation as this will make it easier to find the software if you are a first-time user. 
 

 
 

7. Running up the ACT Mobile Messenger for the first time 
The first time you try to run the first install on the ACT Mobile Messenger on any ACT! Database, it will try to update the 
database with the custom activity type and results types for the Text Message activity type. If you are not logged as an 
administrator as advised in step 2, you will get an error. Please ensure you are logged on as an ACT! Administrator when 
installing the ACT Mobile Messenger for the first time and especially when it is being loaded for the first time with an ACT! 
Database.  
   	
8. Installation complete no errors 
If you are able to start the ACT Mobile Messenger with no errors, then congratulations you have had a successful 
installation. You are now ready to use the ACT Mobile Messenger. ;) 

 

Start Location 
There are many places to start the ACT Mobile Messenger. ACT! is also a very busy application, with many option 
and choices, so we will endeavour to help you find the most logical place for you to start using the ACT Mobile 
Messenger.  

 

 



 

 

	
	

	

Once you have started the software ‘once’ it should be no problem to find it again. 

a) Starting ACT Mobile Messenger using the ‘Write’ Menu 
i) Go to the ‘Write’ Menu in ACT! 
ii) Select ‘SMS Message’ 

 
b) Starting ACT Mobile Messenger using  on the Contact Detail Toolbar 

i) Go to the ‘View’ Menu in ACT! 
ii) Select ‘Contacts’ [F11] or type ‘n’ on the keyboard 
iii) Click on the ACT Mobile Messenger icon in the Toolbar 

 
c) Starting ACT Mobile Messenger using  on the Contact List Toolbar 

i) Go to the ‘View’ Menu in ACT! 
ii) Select ‘Contact List’ [F8] or type ‘l’ on the keyboard 
iii) Click on the ACT Mobile Messenger icon in the Toolbar 

 
d) Starting ACT Mobile Messenger using  on Group Detail Toolbar icon 

i) Go to the ‘View’ Menu in ACT! 
ii) Select ‘Groups’ or type ‘g’ on the keyboard 
iii) Click on the ACT Mobile Messenger icon in the Toolbar 

 
e) Starting ACT Mobile Messenger using  on Group List Toolbar 

i) Go to the ‘View’ Menu in ACT! 
ii) Select ‘Group List’ [F10] or type ‘s’ on the keyboard 
iii) Click on the ACT Mobile Messenger icon in the Toolbar 

 
f) Starting ACT Mobile Messenger using short-cut menu 

i) Go to Contact Screen 
ii) Right-Click on Contact 
iii) Select ‘Write’ 
iv) Select ‘SMS Message’ 

NOTE: During the installation of the ACT Mobile Messenger you may have been asked 
whether you would like to automatically start ACT! and load the ACT Mobile Messenger by 
selecting a tick-box.  

Sending your first Text Message (SMS) from ACT!	
There are many things you do in Act!, that are second nature. However, it is likely your first time sending a Text 
Message from Act! so we would like you to get off on the right foot. In order to send your first SMS Text Message we 
recommend that you do three things: 

1. Ensure that you have your Message Account User Name & Password 
 

 

 



 

 

	
	

	

2. Enter these details into the ACT Mobile Messenger preferences tab 
This can be found in the File Menu under preferences (not in Act!, in the ACT Mobile Messenger). Here you will also 
select your Primary Message Gateway Service Provider. Once you have selected your provider, you will need to enter a 
name for your account (Alias/Label) along with your User name and Password. 

 
3. Send a Test Message 
Send a Test Message to yourself to ensure your messages are getting through. The ‘Test’ button allows you to send a 
test message to the number listed in your MyRecord (generally your number) or any number you choose. This is the 
fastest way to get a message out and test the service. It is also a good way to check you have entered your account 
details correctly. 

 

If the account details were entered correctly and the number was valid, you will receive a confirmation that the Message 
Test Completed and you would have received it on your phone by now.  

 

 
 

If not please check the Troubleshooting section in the following pages. 
 
 
 
 
 
 
 
 
 



 

 

	
	

	

Send a Quick SMS – Step-by-Step 
 
Step 1: Simple Message Screen 
In the ACT Mobile Messenger, go to the View Menu and select either ‘Simple’ or ‘Advanced’ until you find the Simple screen 
as displayed above which is used for sending single messages from Act!. Function Key [F7] also allows you to flip screens. 
 
Step 2: Quick SMS Checkbox 

Click on the small checkbox that says Quick SMS and ensure that there is a tick [ü] in the box. This places you in Quick 
SMS mode and will allow you to enter details for a message recipient that has not already been entered into ACT!	
 
Step 3: Enter Details 
Enter the Name and Mobile of the person you want to send the message to.  
 
SPECIAL NOTE: It is recommended that when sending your first message, you send the message to yourself or your own 
cell/mobile phone so that you can see both the message being sent and the message being received. 
 
Step 4: Message  
Enter the Message you want to send which can be up to 160 characters in length for a single message. If your message is 
longer it will be sent as multiple messages. 
 
Step 5: Send Message 
Once you are satisfied you have followed steps 1 to 4 and have entered the correct information then you may click on the 
‘Send Message’ button to send your message.  
 
Next Steps: 
 
If everything went to plan you will see a message on the screen like this; 
 

 
 
You will also notice that the message details have been recorded in the history, notes or selected field of your MyRecord. 
These details include the following information; 

a) Date 
b) Time 
c) Result 
d) Regarding & Details 
e) Record Manager (Sender) 
f) Contact Record (Recipient)  

 
 



 

 

	
	

	

Finally, if everything has worked well, you should have received the message on you cell or mobile phone. The speed at 
which this occurs will depend on your Internet connection and the performance of your selected messaging gateway. 

 

 
 
SUCCESS! 
 
If you have succeeded in sending your first text message from Act! using the Quick SMS feature, it is recommended that 
you move onto sending messages to contacts or groups within Act! …  
WELL DONE & CONGRATULATIONS! 
 
PROBLEMS? 
 
If you have not received you message it could be for one of the following reasons: 

 

Troubleshooting 
The most common reasons for not receiving messages are as follows: 

1) There is no internet connection available to send a message 
2) There may be a firewall restriction on your internet service 
3) The user name and password for the message account is not valid 
4) There are no message credits left on your message account 
5) The Cell Phone or Mobile number you have used is not formatted correctly  
6) The Cell Phone or Mobile number being used is wrong 
7) The message text contains special characters that are not supported by your provider 
8) The message provider’s service (messaging gateway) is down for some reason 
9) You have not installed the software correctly or were not logged on as an administrator when doing so 
10) You are trying to use the software outside of license conditions such as a virtualized environment or shared server 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

	
	

	

Choice of Providers 
Choose your Message Provider (SMS/Text Message Service Provider): 
It is important to choose the right provider because depending on where you are located in the world, you will want to find 
the provider that gives you the best balance of price, performance and deliverability. It is of no use to have ‘cheap’ or ‘free’ 
messages if they are not being delivered or arriving much later than anticipated. There are presently fourteen (14) Message 
Gateway Service Providers supported by ACT Mobile Messenger that allow you to send Text Messages (SMS) over the 
Internet directly from Act!, using an internet connection. Depending on whether or not you presently use one of these 
providers you will need to follow step A) or step B) 
 
A. I already have an ongoing message account with one of the following providers: 
 

Bulletin Messenger - http://www.bulletin.net 
Clickatell – http://www.clickatell.com 
Esendex – http://www.esendex.com 
Frontier Texting – http://www.frontiertexting.com 
MessageMedia - http://www.message-media.com 
MessageNet - http://www.messagenet.com.au 
Nexmo – http://www.nexmo.com 
RedCoal– http://www.redcoal.net 
RingCentral – http://www.ringcentral.com 
SMSGlobal – http://www.smsglobal.com 
SMSTech – http://www.smstech.com.au 
Twilio – http://www.twilio.com 
Upside Wireless – http://www.upsidewireless.com 
Webtext – http://www.webtext.com 
Zipwhip – http://www.zipwhip.com 

NOTE: List of Supported Providers as at December 2018 

If you already use one of these message providers then you are already know about sending messages over the 
Internet and should have your own user name & password, which you would have received from your provider. If you 
have forgotten these details it is recommended that you contact your service provider to get your user account details, 
as they will be crucial to ensuring that your messages can be sent. 

 B. I don’t have an account, I’m not sure how to get one, where are my FREE messages?  
If you do not have a message account you will need to get one as you will not be able to send any messages without 
one. Each of the three messages gateway providers we use have their own pros and cons and they all offer trial 
accounts with ‘FREE’ messages in order to try them out before deciding which one is best for you. 

Setting Up a Messaging Account:  
It is quite simple to setup up an account with each of the message providers. All you need to do is visit the websites of 
any of the message service providers listed above and find the sections relating to setting up a trial account, which will 
normally be on the front page or home page in most cases. The following pages show you where to start in setting up 
your trial account to access your ‘FREE’ messages to start using the ACT Mobile Messenger. 

 

 

 

 

 

 

 

 



 

 

	
	

	

Message Gateway (Provider) – Feature Matrix (Global Providers) 
Feature (Capability) Bulletin Clickatell Esendex Message 

Media Nexmo Ring 
Central 

SMS 
Global 

SMS 
Tech Twilio Webtext Zipwhip 

(Frontier) 

Rating (1-5 Stars) «««« «« «««« ««« « ««« ««« «« «««« « ««« 

1) Free Text Messages (Trial Period) ü ü ü ü û û ü ü û ü ü 

2) Send Text Messages To: (Cell/Mobile/Device) ü ü ü ü ü ü ü ü ü ü ü 

3) Receive Text Messages From: (Cell/Mobile/Device) ü û ü ü ü ü ü û ü û ü 

4) Reply or Callback URL Not Required (Hosting) ü û ü ü ü ü ü û ü û ü 

5) Replies to My Phone (Cell/Mobile/Device) û ü ü û û û ü ü û ü ü 

6) Replies to My Email (E-mail Forwarding) ü ü ü ü ü ü ü ü ü û û 

7) Replies to Virtual Number (VN) [Long Code] ü ü ü ü ü ü ü ü ü û ü 

8) Customize Sender Phone Number (Own Number) û û ü û û û û ü û û ü 

9) Customize Sender with Text or Name û û ü û û û û ü û û û 

10) System Generated Sender (Pool) ü ü û ü ü û û ü û ü ü 

11) Multimedia Message Service (MMS) Support û û û û û ü ü û ü û ü 

12) Rich Communication Service (RCS) Support û û ? û û û û û ? û û 

13) Confirmation Receipts ü ü ü ü ü ü ü ü ü ü ü 

14) Read Receipts ü û û û û û û û ü û û 

15) Virtual Number included (Dedicated) û û ü û û ü û û û û û 

16) Virtual Number Purchase (Additional Cost) ü ü ü ü ü û ü ü ü ü ü 

17) Alpha codes available [Short Code] ü ü ü ü ü û ü ü û ü ü 

18) Option of Prepaid Account ü ü ü ü û û ü ü ü ü ü 

19) Account Establishment (Setup) Fee û û ü ü ü û ü û û û û 

20) Monthly Account Fee û û ü ü ü ü ü ü û ü ü 

21) Multiple User Accounts (Logins) ü ü ü ü ü ü ü ü ü ü ü 

22) Customize Daily Message Limits ü û ü ü ü ü û û ü ü ü 

23) Message Credits do not expire ü ü û û û ü û û ü û û 

24) Web Application ü ü ü ü ü ü ü ü ü ü ü 

25) Phone Application (Android App) ü û û û û ü û û û û ü 

26) Phone Application (iPhone App) ü û û û û ü û û û û ü 

27) Outlook Add-in ü û ü ü û û ü ü û ü ü 

28) Region Support - USA ü ü ü ü ü ü ü ü ü ü ü 

29) Region Support - Canada û û û û ü ü û ü ü ü ü 

30) Region Support - UK ü ü ü ü û ü ü ü ü ü ü 

31) Region Support - Ireland û û û û û û û û û ü û 

32) Region Support - Australia ü û ü ü û û ü ü û û û 

33) Region Support – Asia-Pacific ü ü ü ü û ü ü ü ü û û 

34) Region Support - Europe ü ü ü ü û û ü û û ü ü 

35) Region Support – Middle East ü ü ü ü û û ü û û û û 

36) Region Support - Africa û ü û û û û ü û û û û 

 
 
 
 
 



 

 

	
	

	

Message Gateway Contact Points 
Message Gateway Location Address Contact Phone 

Bulletin 
www.bulletin.net 

United States Level 8, 200 S. Virginia Street 
Reno NV 89501 Dustin Thornton +1 775 771 7090 

United Kingdom Level 1, Holborn Gate, 330 High 
Holborn London WC1V 7QT Shaun Hockaday +44 20 7969 2712 

Australia PO Box 1542  
Warriewood Square NSW 2102 Annette Tregidga 1300 270 807 

New Zealand Level 8, 16 Kingston Street 
Auckland 1141 Mitendra Das +64 9307 1146 

Clickatell 
www.clickatell.com 

United States Suite 201, 3200 Bridge Parkway 
Redwood City CA 94065 Abraham Milan +1 (650) 241-4190 

South Africa Level 7, 100 Edward Street  
Belville 7530 Cape Town Francois De Lange +27 21 910 7700 

Esendex 
www.esendex.com United States Suite 1500, 50 California Street, 

San Francisco CA 94111 Chris Bartlett +1 866 356 4694 

United Kingdom 20 Wollaton Street  
Nottingham NG1 5FW Paul Spencer +44 115 958 1400 

Australia 101 Bay Street 
Brighton VIC 3186 Chris Bartlett 1300 764 946 

MessageMedia 
www.message-media.com 

United States Suite 102, 580 Howard Street,    
San Francisco, CA 94105 Danny Fonzi +1 888 799 9767 

United Kingdom Level 6, 52 Grosvenor Gardens, 
Victoria London SW1W 0AU Dominic Wates +44 808 234 8246 

Australia Level 22, 385 Bourke Street, 
Melbourne VIC 3000 Craig Keating 1800 009 767 

SMS Global 
www.smsglobal.com Australia 96-98 Market Street 

South Melbourne VIC 3205 Paul McKenna 1300 883 400 

SMS Tech 
www.smstech.com.au Australia Level 22, 385 Bourke Street 

Melbourne VIC 3205 Richard Hay 1800 155 228 

Twilio 
www.twilio.com United States 

Level 3, 645 Harrison St 
San Francisco CA 94107 
399 W. El Camino Real 

Mountain View CA 94040 
 

Jeff Lawson +1 (877) 889 4546 

Upside Wireless 
www.upsidewireless.com Canada 

 
Suite 503, 553 Thurlow St 
Vancouver BC V6E 3L2 

 
Branko Zurkovic +1 (604) 687 7433 

Webtext 
www.webtext.com 

United Kingdom 
Ireland 

United States 
Canada 

                 4-5 High St 
Galway BC Ireland 

Suite 201, 36E Main St 
Norristown PA 19401 

 

AJ Cahill 

 
+44 20 3328 5053 
+353 01 2479000 
+1 (855) 247 3232 

Zipwhip 
www.zipwhip.com United States 

                  
Suite 600 

2410 4th Avenue 
Seattle WA 98121 

 

Justin Ellis 

 
  +1 (855) ZIPWHIP 
+1 (855) 947 9447 

 
NOTE: The features matrix is published as a guide only. Any specific questions or clarifications regarding features or 
functionality should be directed to the message gateway concerned. The contact points listed above were valid at time of 
publishing, but may have changed so please refer to websites if contact points are no longer current. 



 

 

	
	

	

 
Bulletin.net - Bulletin Messenger – http://www.bulletin.net 

 
 

Clickatell.com – Communicator 2 – http://www.clickatell.com  



 

 

	
	

	

	
Esendex – http://www.esendex.com 

	
MessageMedia – http://www.message-media.com 



 

 

	
	

	

	
MessageNet – http://www.messagenet.com.au 

 

	
Mobile Messenger – http://www.mobilemessenger.com 

 

 



 

 

	
	

	

 

RedCoal – http://www.redcoal.net 

 

SMSGlobal – http://www.smsglobal.com 

 

 



 

 

	
	

	

 

Twilio – http://www.twilio.com 

 

Upside Wireless – http://www.upsidewireless.com 



 

 

	
	

	

 

Webtext – http://www.webtext.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

	
	

	

 

Purchasing ACT Mobile Messenger 
To purchase, go to the ACT Mobile Messenger site to the ‘BUY’ page at http://www.actmobilemessenger.com/buy/buy.html  

Please register your software to ensure you receive updates when they become available.  

Email not setup?  
If you have not setup your email in Act!, don’t worry. When you click on the Buy button it will automatically copy your 
details into the windows clipboard and you can paste these into a document or email, that can be sent to your reseller. 

	

Registering ACT Mobile Messenger 
Once you have purchased your copy of ACT Mobile Messenger you will receive an Activation Key from your reseller that 
will enable you to unlock the software. All you need to do is enter the Key and press the Unlock button. 

Computer ID & Key: 
The key generation process is very secure and is specific to each machine that the ACT Mobile Messenger is installed 
on. This is for protection of the license and also allows you to keep the same installation and registration even when we 
send you updated software. This means that it is rare that you will have to re-register your software unless you 
completely reformat your machine. However, we do understand that most of our users do these sorts of things at odd 
hours and may need to register their software outside normal business hours.  If you have a situation like this please 
send an email with a screen shot with your registration details and we will do our best to get you registered as soon as 
possible. However, remember that if you have re-formatted your machine you can go back to trial software until such 
time as your receive your official registration. 

	

	

Feedback 
We are very keen for you to share your experiences in using this guide and commencing your use of ACT Mobile 
Messenger. If you have any recommendations or criticisms please let us know as it is with certainty that we will take 
them on board and address them. You can email us at feedback@actmobilemessenger.com 

	

Thanks 
We really appreciate that you have taken your personal or business time to give consideration to a product that we are 
proud of and user have told us they love. We are continually working to improve the product and your thoughts and 
ideas are always welcome as well as any issues or criticisms you may have.  We would love to have you as a customer 
and active user of our software.  


